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Important information

This manual is part of the product.

Carefully read this manual and observe all instructions.

Keep this manual for future reference.

Hand this manual and all other pertinent product documentation over to 
all users of the product.

Carefully read and observe all safety instructions and the chapter "Be-
fore you begin - safety information".

Some products are not available in all countries.
For information on the availability of products, please consult the cata-
log.

Subject to technical modifications without notice.

All details provided are technical data which do not constitute warranted 
qualities.

Most of the product designations are registered trademarks of their re-
spective owners, even if this is not explicitly indicated.
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Writing conventions and symbols

Work steps If work steps must be performed consecutively, this sequence of steps 
is represented as follows:

� Special prerequisites for the following work steps

� Step 1

� Specific response to this work step

� Step 2

If a response to a work step is indicated, this allows you to verify that the 
work step has been performed correctly.

Unless otherwise stated, the individual steps must be performed in the 
specified sequence.

Bulleted lists The items in bulleted lists are sorted alphanumerically or by priority. Bul-
leted lists are structured as follows:

• Item 1 of bulleted list

• Item 2 of bulleted list

– Subitem for 2

– Subitem for 2

• Item 3 of bulleted list

Making work easier Information on making work easier is highlighted by this symbol:

Sections highlighted this way provide supplementary 
information on making work easier.

Menu paths "⇒" Action steps within the menu are described with complete menu path 
and the "⇒" symbol,
e.g. "⇒ File ⇒ Save As...".

SI units SI units are the original values. Converted units are shown in brackets 
behind the original value; they may be rounded.

Example:
Minimum conductor cross section: 1.5 mm2 (AWG 14)
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1 Introduction

1.1 General features

The Lexium CT commissioning software is an application program for 
PCs that allows you to commission and diagnose many of our products.

The functions of the commissioning software automatically adapt to the 
products. Therefore, some functions may not be available. For details 
see the product manual.

The Lexium CT commissioning software consist of 3 different user inter-
faces:

• Lexium CT ProductExplorer

• Lexium CT M1

• Lexium CT M2

The "Lexium CT ProductExplorer" is used to scan fieldbus networks for 
products or to read information directly from supported products. The 
"Lexium CT ProductExplorer" provides additional information on the 
supported products such as the product manual or information from the 
Internet. If a device is found on the fieldbus network, it is possible to es-
tablish a connection with the product without additional connection set-
tings. The "Lexium CT ProductExplorer" automatically selects the 
appropriate user interface, "Lexium CT M1" or "Lexium CT M2", for the 
product. "Lexium CT M1" or "Lexium CT M2" are used to commission 
the product.

Functions of the commissioning
software

The functions of the commissioning software include:

• Scan various fieldbuses for devices

• Extensive information on connected devices

• Display and enter device parameters

• Archive and duplicate device parameters

• Manual positioning of the motor

• Test input and output signals

• Record, evaluate and archive motion and signals

• Error diagnostics

• Optimize control behavior (servo motors only)

Supported devices The product manual of the specific device describes whether the com-
missioning software can be operated with the device.

You must be familiar with the Windows operating system to 
work with the commissioning software.
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2 Before you begin - safety information

2.1 Qualification of personnel

Only appropriately trained persons who are familiar with and understand 
the contents of this manual and all other pertinent product documenta-
tion are authorized to work on and with this product. In addition, these 
persons must have received safety training to recognize and avoid haz-
ards involved. These persons must have sufficient technical training, 
knowledge and experience and be able to foresee and detect potential 
hazards that may be caused by using the product, by changing the set-
tings and by the mechanical, electrical and electronic equipment of the 
entire system in which the product is used.

All persons working on and with the product must be fully familiar with all 
applicable standards, directives, and accident prevention regulations 
when performing such work.

2.2 Intended use

This product is a commissioning software and intended for industrial use 
according to this manual.

The commissioning software is intended for commissioning and diag-
nostics of the supported products. The supported products are dis-
played by the user interface. Do not use the software to operate 
products.

The product may only be used in compliance with all applicable safety 
regulations and directives, the specified requirements and the technical 
data.

The information concerning the intended use of the products also ap-
plies.

Any use other than the use explicitly permitted is prohibited and can re-
sult in hazards.
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2.3 Hazard categories

Safety instructions to the user are highlighted by safety alert symbols in 
the manual. In addition, labels with symbols and/or instructions are at-
tached to the product that alert you to potential hazards.

Depending on the seriousness of the hazard, the safety instructions are 
divided into 4 hazard categories.

@ DANGER

DANGER indicates an imminently hazardous situation, which, if not 
avoided, will result in death or serious injury.

@ WARNING

WARNING indicates a potentially hazardous situation, which, if not 
avoided, can result in death, serious injury, or equipment damage.

@ CAUTION

CAUTION indicates a potentially hazardous situation, which, if not 
avoided, can result in injury or equipment damage.

 CAUTION

CAUTION used without the safety alert symbol, is used to address 
practices not related to personal injury (e.g. can result in equipment 
damage).
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2.4 Basic information

@ WARNING
LOSS OF CONTROL

Misoperation of the PC or the software may result in a loss of control 
of the system (no stop, unexpected responses). 

• Verify that a functioning button for EMERGENCY STOP is within 
reach.

• Verify that the system is free and ready for the motion before con-
necting the system to the PC.

Failure to follow these instructions can result in death, serious 
injury or equipment damage.

@ WARNING
UNEXPECTED MOVEMENT

When the drive is operated for the first time, there is a risk of unex-
pected movements caused by possible wiring errors or unsuitable pa-
rameters.

• Perform the first test run without coupled loads.

• Verify that a functioning button for EMERGENCY STOP is within 
reach.

• Anticipate movements in the incorrect direction or oscillation of 
the drive.

• Only start the system if there are no persons or obstructions in 
the hazardous area.

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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2.5 Standards and terminology

Technical terms, terminology and the corresponding descriptions in this 
manual are intended to use the terms or definitions of the pertinent 
standards.

In the area of drive systems, this includes, but is not limited to, terms 
such as "safety function", "safe state", "fault", "fault reset", "failure", "er-
ror", "error message", "warning", "warning message", "alarm", etc.

Among others, these standards include:

• IEC 61800 series: "Adjustable speed electrical power drive sys-
tems"

• IEC 61800-7 series: "Adjustable speed electrical power drive sys-
tems - Part 7-1: Generic interface and use of profiles for power drive 
systems - Interface definition"

• IEC 61158 series: "Industrial communication networks - Fieldbus 
specifications"

• IEC 61784 series: "Industrial communication networks - Profiles"

• IEC 61508 series: "Functional safety of electrical/electronic/pro-
grammable electronic safety-related systems"

Also see the glossary at the end of this manual.
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3 Installation

Source commissioning software The latest version of the commissioning software is available for down-
load from the internet:

http://www.schneider-electric.com

3.1 PC requirements

System requirements The minimum hardware requirements for installation and operation of 
the software are:

• IBM-compatible PC

• Approx. 200 MB of hard disk space

• 512 MB RAM

• Graphics card and monitor with a resolution of at least 1024x768 
pixels

• Free serial interface (RS232) or free USB interface

• Operating system Windows 2000, Windows XP Professional or 
Windows Vista

• Acrobat Reader 5.0 or newer

• Internet connection (for initial installation and updates)

Required accessories • RS232 to RS485 converter or USB to RS485 converter

3.2 Installation procedure

We recommend backing up important data regularly and always before 
installing new software.

� Verify the PC meets the requirements.

� Verify that you can connect to the internet.

� Start the installation via the file "LexiumCTInstall.exe".

� The following dialog box is displayed:

Interface PC interface Required  fieldbus 
converter

Source

RS485 RS232 NuDAM ND-6520 http://www.acceed.com

RS485 USB NuDAM ND-6530 http://www.acceed.com

CAN parallel PCAN dongle, Peak http://www.peak-system.com

CAN USB PCAN-USB, Peak http://www.peak-system.com

PROFIBUS DP PCMCIA Siemens CP5611/13 www.ad.siemens.de

PROFIBUS DP PCI Siemens CP5611/12 www.ad.siemens.de

PROFIBUS DP USB PROFIusb PB-USB http://www.softing.com

DeviceNet USB USB to CAN compact www.ixxat.com
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� Select the installation language from the drop-down menu.

� The following dialog box is displayed:

Internet connection via proxy server � Check whether your site uses a proxy server (if necessary, get in 
touch with your network administrator). If you are in a network that 
uses a proxy server to connect to the internet, proceed as follows:

� Check the "Edit Proxy settings" and click the "Next" button.

� The following dialog box is displayed:
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� Click "Read settings from Internet-Explorer" or enter the information 
for your proxy server in the appropriate fields. Please check back 
with your network administrator for the required connection informa-
tion.

� Click "Next".

Internet connection without proxy
server

� If you do not use a proxy server, proceed as follows:

� Click "Next" without checking the "Edit Proxy settings" checkbox or 
select "Direct connection" in the "Proxy settings" dialog box.

Selecting the used products � If necessary, the correct proxy server settings have been entered 
and a connection to the internet has been established.

� The following dialog box is displayed:
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� Check each product that you want to commission with the commis-
sioning software.

It is possible to add individual products to the list at a later point in 
time. To do so, choose "Internet Update" from the Windows Start 
menu (" ⇒ Start ⇒ Programs ⇒ Schneider Electric ⇒ Lexium CT").

The program is installed in the folder "%ProgramFiles%\Schneider Elec-
tric\Lexium CT".

A shortcut is created in the Windows start menu for starting the commis-
sioning software.

Creating media for offline
installation

Check the "Create media for an offline installation" to create an up-to-
date installation routine on your hard disk. This routine can be copied to 
another computer that does not have an internet connection (use a flash 
drive, for example).

If you have checked the "Create media for an offline installation", the 
software will prompt you for a target folder. The offline installation re-
quires up to 200 MB of free disk space.
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4 Lexium CT ProductExplorer

The commissiong software can be started via the shortcut in the Win-
dows Start menu (" ⇒ Start ⇒ Programs ⇒ Schneider Electric ⇒ Lex-
ium CT").

4.1 The user interface

The screenshot shows the user interface of the ProductExplorer.

Figure 4.1 Elements of the ProductExplorer

(1) Menu bar
(2) Tree View
(3) Detail View
(4) Status bar

The functions of the commissioning software can be executed via the 
menu bar and, to a large degree, by means of right-clicking or double-
clicking.



20 Commissioning software

4 Lexium CT ProductExplorer Lexium CT

01
98

44
11

13
73

6,
 V

2.
00

, 0
9.

20
08

4.1.1 The menu bar

The menu bar provides access to the functions of the software. It struc-
tures the functions just like in other application programs.

If you move the mouse pointer over a button, the software 
displays a "Tooltip"; in addition, a short description of the 
function may be shown in the "status bar".

4.1.2 Tree View

Figure 4.2 Tree View

The Tree View allows you to access the individual devices. The view is 
divided into two areas:

• Scanning the network

The devices are grouped by fieldbus. You can scan a fieldbus net-
work with different device types and unknown addresses. The 
devices found will be displayed in an overview list.

• Supported drives

The devices are grouped by model. The available fieldbuses are 
shown below the product. In addition, you can access the corre-
sponding manuals and product information.
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4.1.3 Detail View

Figure 4.3 Detail View

The Detail View provides the following functions:

• Display of detailed information on devices found on the network

• Display of product manuals

• Access to online information on the products
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4.2 First steps

4.2.1 Important terms

Data interface Depending on the product, data communication is performed via "Mod-
bus RTU", "DeviceNet", "RS485 für ILx1", "CANopen DS301" or "Mobus 
TCP". RS485 is the standard commission interface; it is available for all 
products. Depending on the product, the RS485 protocol used is either 
a vendor-specific protocol (ILx1) or the "Modbus RTU" protocol.

Update Updates are used to get the latest version of the software. You need an 
internet connection to update the software. If you encounter problems 
during an update, have your internet access checked by your network 
administrator. It is recommended to update the software at regular inter-
vals.

The software can automatically check for available updates. If the soft-
ware is running, a background process checks whether new updates are 
available. To use this function:

� Use the following menu item "⇒ Extras ⇒ Settings"

� The following dialog box is displayed:

� Check the "Automatically check for updates for: -Lexium CT" check-
box.

� Depending on your preferences, the updates can be installed imme-
diately or after the next start of the software.

To start an update manually:

� Save all data and quit the " Lexium CT M1" and "Lexium CT M2" 
user interfaces.

� Use the following menu item: "⇒ Help ⇒ Check for updates"

� The software prompts you for confirmation.

� Click "Yes".

� The "Lexium CT ProductExplorer" user interface is closed and the 
update process is started. The system displays the "Lexium CT 
Updater". 

� Follow the instructions on page 16.
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4.2.2 Connection prerequisites

Check the following before you establish the first connection:

• Have you switched on the product?

• Do you need a driver for the fieldbus converter used; have you 
installed this driver?

• Did you properly connect all cables and fieldbus converters?

• Has the product been installed during the installation process?

4.2.3 Scanning the network

The Tree View to the left provides the function "Search the network". The 
function "Search the network" scans a defined network range for prod-
ucts.

To scan the network:

� Double-click "Configuration" below the appropriate fieldbus protocol 
node.

� The following dialog box is displayed:

Figure 4.4 Network scan

� Set the values as required for your product and click "OK".

� Right-click "Network" below the appropriate fieldbus protocol node 
and select "Configure the network scan".
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� The following dialog box is displayed:

Figure 4.5 Network scan range

� Set the address range you want to scan and click "OK".

If you have already set the network range, the range is automati-
cally scanned when you click "Network". To select a different range, 
right-click "Network" and select "Configure the network scan".

� If one or more products are found, the software displays the window 
"Product found" with the data of the found products. If newer prod-
ucts are found, the "Detail View" displays detailed product informa-
tion.

Figure 4.6 Devices found
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Connecting to devices found � The network scan found one or more products.

� Select the desired product from the list and click the "Connect" but-
ton.

� Depending on the product, the system displays "Lexium CT M1" or 
"Lexium CT M2". The connection settings are automatically made 
available in the windows of "Lexium CT M1" or "Lexium CT M2". In 
the new window, click "Connect".

4.2.4 Direct connection to supported products

If the connection data and the device type are known, you can directly 
establish a connection to the product.

� Double-click the fieldbus protocol to be used below the product 
name node.

� The following dialog box is displayed:

� Adjust the connection settings for your product and click "OK".
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� If a product is found, the software displays a window with device 
information. At the same time, the "Detail View" provides detailed 
product information:

� Double-click a list entry in the "Product found" window to start the 
commissioning software for the corresponding product.
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5 Lexium CT M1

Depending on the product, the "Lexium CT ProductExplorer" starts the 
"Lexium CT M1" software.

5.1 The user interface

The following screenshot shows the user interface of the commissioning 
software.

Figure 5.1 User interface Lexium CT M1

(1) Menu bar
(2) Toolbar
(3) Control bar and status bar

The functions of the commissioning software can be accessed via the 
menu bar, the toolbar, the control bar and the status bar.
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5.1.1 The menu bar

The menu bar adapts to the task at hand. It only contains the functions 
required for and possible in the current situation.

For example, if there is no connection to the device, the function "⇒ 
Connection ⇒ Disconnect" is not available.

5.1.2 The toolbar

The toolbar provides fast, single-click access to frequently used func-
tions.

The buttons let you execute the following functions:

Figure 5.2 Toolbar

(1) ⇒ File ⇒ Open...
(2) ⇒ File ⇒ Save
(3) ⇒ Connection ⇒ RS485 connection...
(4) ⇒ Connection ⇒ Disconnect
(5) ⇒ Connection ⇒ Options
(6) ⇒ Parameter ⇒ Open parameter window...
(7) ⇒ Functions ⇒ Operating modes...
(8) ⇒ Functions ⇒ Record/Tuning...
(9) ⇒ Functions ⇒ Inputs+Outputs...
(10) ⇒ Diagnostics ⇒ Device info...
(11) ⇒ Diagnostics ⇒ Error memory...
(12) ⇒ Diagnostics ⇒ Object monitoring...

If you move the mouse pointer over a button, the software 
displays a "Tooltip"; in addition, a short description of the 
function may be shown in the "status bar".
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5.1.3 Control bar and status bar

The control bar and the status bar allow you to access the device. The 
control bar and the status bar can be used to enable the power stage 
and display various status information.

Figure 5.3 Control bar and status bar

(1) Enable
(2) Status information
(3) Operating state
(4) Stop
(5) Reset
(6) Current error

Enable The switch "Enable" allows you to enable and disable the power stage of 
the device. For more information on enabling or disabling the power 
stage see the product manual of the device.

Status information This information consists of:

• Line 1 shows whether the function "Halt" is active

• Line 2 displays the current motor position

• Line 3 shows the status of the access control

• Line 4 shows the control mode

Operating state The commissioning software shows the current operating state of the 
connected device. For more information on the operating state see the 
product manual of the device.

Stop The "Stop" button allows you to stop the motor with a "Quick Stop". For 
more information on "Quick Stop" see the product manual of the device.

Reset The "Reset" button is used to acknowledge an error message. For more 
information on acknowledging error messages see the product manual 
of the device.

Current error The field shows the currently active asynchronous error.

5.2 First steps

5.2.1 Important terms

Device data The term device data refers to all parameter values of a device. They are 
saved to the EEPROM of the device to avoid loss in case of a power out-
age.

Transferring device data Device data can be transferred between the device and the PC only if 
there is a connection. It is possible to transfer all parameters or groups 
of parameters.
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NOTE: In a first step, the commissioning software transfers modified pa-
rameters to the RAM memory of the device. They remain there until the 
controller supply voltage is switched off . Note that the device data must 
be saved separately to the EEPROM memory so they are permanently 
available to the product.

Parameter file The device data can be saved to the PC and loaded.

On the PC, all device data is saved in one file, the parameter file. The 
commissioning software saves the complete parameter set in the file.

The PC and the device do not have to be connected if you want to edit 
the parameter file.
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5.2.2 The first connection

The device must be connected to the PC via the data interface.

Use the menu item "⇒ Connection ⇒ RS485 connection...." to connect 
to the device. This opens the "Connection" dialog box.

The screenshot below shows an example.

Figure 5.4 Selecting the connection data

If you want to use a different fieldbus interface, selected it with the menu 
item "⇒ Connection ⇒ Options...":

Connection The device data is transferred to the PC when a connection is estab-
lished. After transfer the commissioning software is connected to the de-
vice in online mode.
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5.3 Parameter file

Parameter files have the extension ".ifx". Even if there is no connection 
to the device, you can open and edit any device file on the PC. In addition 
to the parameter values, the file contains the contents of the error mem-
ory, all actual values and recorded data.

5.3.1 Saving a file

On the PC, device data on the PC can be saved to a parameter file, for 
example, to archive it for maintenance and service purposes. This also 
allows you to quickly commission additional devices of the same device 
version.

To save a parameter file on the PC, use the menu items"⇒ File ⇒ 
Save..." or "⇒ File ⇒ Save as...."

It is recommended to save all device data in the form of a 
parameter file after you have commissioned a device. This 
way the device can be put back into operation immediately 
after a repair.

5.3.2 Opening a file

Use the menu item "⇒ File ⇒ Open..." to open a parameter file on the 
PC.

If there is a connection to the device, the commissioning software 
checks whether the parameter file is compatible with the device.

If the parameter file is compatible with the device, the stored parameter 
values of the parameter file are compared to the parameter values of the 
device. Differences are highlighted by a colored background.

If the parameter file is not compatible with the device, the loading proc-
ess is canceled and an error message is displayed.



01
98

44
11

13
73

6,
 V

2.
00

, 0
9.

20
08

Lexium CT 5 Lexium CT M1

Commissioning software 33

5.3.3 Exporting parameters

All device parameters that can be written can be saved as a .csv file for 
further processing. This function can be accessed via the menu item "⇒ 
File ⇒ Export parameters...".

The file is saved with the extension ".csv". You can open and edit this file 
Microsoft Excel.

5.3.4 Printing parameters

The menu item "⇒ File ⇒ Print parameters..." allows you to print the de-
vice data. The printed data is arranged in groups:

• Config

• RS485

• Settings

• Motion

• I/O

• Homing

• Manual

• DataSet

• ProgIO0

• ProgIO1

• ProgIO2

• ProgIO3

In addition, the device type, serial number and information on the soft-
ware are printed.
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5.4 Parameterization

The data of a device can be edited in the "Parameter" window. A con-
nection to the device is not required. The parameter values of a file can 
be modified in off-line mode and transferred to the device at a later point 
in time.

5.4.1 Opening the parameter window

Use the menu item "⇒ Parameter ⇒ Open parameter window..." to open 
the Parameter window.

Figure 5.5 Parameter window

The screenshot shows the parameter window. The contents of this win-
dow depends on the device version. However, the general structure is al-
ways the same. The left pane shows items, the associated parameters 
are displayed in the right pane.

Parameters of a group The parameter window shows the parameters associated with the se-
lected item. The list shows the names, values, unit, a description, the 
range and the Modbus address.

Changing parameter values The value of a parameter is changed in the "Value" column. Values with 
a gray background are read-only and cannot be modified.

Modified values that have not been transferred to the device are high-
lighted by a colored background. At the same time the parameter group 
to which the parameter belongs is highlighted by a red exclamation 
mark. As soon as the values have been transmitted to the device, the ex-
clamation mark is cleared.

To change a parameter value, you can enter the new value directly or 
choose it from a list.

Checking the value range The commissioning software checks whether the parameter values en-
tered are in the permissible value range. If the value entered is not in the 
valid range, the value is not accepted.
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5.4.2 Transferring parameter values

When the controller supply voltage to the device is switched on, the de-
vice data is automatically copied from the EEPROM to the RAM. The de-
vices only operate with the data contained in the RAM.

The data exchange between the device and the PC is controlled by the 
following menu items and buttons.

Menu items The menu items "⇒ Parameter ⇒ Send parameter group to drive" and 
"⇒ Parameter ⇒ Send all parameters to drive" allow you to transmit pa-
rameter values from the PC to the device.

The menu items "⇒ Parameter ⇒ Load parameter group from drive" and 
"⇒ Parameter ⇒ Load all parameters from drive" are used to transmit 
parameter values from the device to the PC.

Buttons The buttons let you execute the following functions:

Figure 5.6 Buttons for data transmission

(1) ⇒ Parameter ⇒ Send parameter group to drive
(2) ⇒ Parameter ⇒ Load parameter group from drive
(3) ⇒ Parameter ⇒ Send all parameters to drive
(4) ⇒ Parameter ⇒ Load all parameters from drive
(5) ⇒ Parameter ⇒ Save device parameters in EEPROM

Not all parameters can be transferred in operating state 
"Operation Enable". Parameter values that cannot be 
transferred are highlighted by a colored background.
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5.4.3 Restoring the factory settings

Use the menu item "⇒ Parameter ⇒ Reset to factory settings" to restore 
the factory settings of all parameters.

Figure 5.7 Restoring the factory settings

After confirmation with "OK" all device parameters are reset to the fac-
tory setting.
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5.5  Functions

The "Functions" menu provides access to the following functions:

• Operating modes

• Recording and tuning

• Inputs and outputs

The screenshots below may be different or unavailable in 
your system due to different functionalities of the devices.

5.5.1 Changing the operating state

The device can now be set to operating state 6 "Operation Enable" with 
the commissioning software. In this operating state the power stage of 
the device is enabled. To do so, click the "Enable" switch. For more in-
formation on enabling or disabling the power stage see the product man-
ual of the device.

The device must be in operating state 6 "Operation Enable" for the func-
tions of the commissioning software to be executed.

5.5.2 Operating modes

Use the menu item "⇒ Functions ⇒ Operating modes..." to start the 
"Operating modes" function.

The various operating modes can be selected from the tabs in the Op-
erating Modes window.

The window is subdivided into two sections:

• Tab for the selected operating mode and for setting specific param-
eters (top section)

• Display of some status information (bottom section)

The user can switch between the tabs in the Operating Modes window 
without interfering with a currently active operating mode.

@ WARNING
UNEXPECTED MOVEMENT

When the drive is operated for the first time, there is a risk of unex-
pected movements caused by possible wiring errors or unsuitable pa-
rameters.

• Perform the first test run without coupled loads.

• Verify that a functioning button for EMERGENCY STOP is within 
reach.

• Anticipate movements in the incorrect direction or oscillation of 
the drive.

• Only start the system if there are no persons or obstructions in 
the hazardous area.

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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Device monitoring During movements, the connection to the device is cyclically monitored. 
If the connection between the PC and device is lost, the motor stops 
within the cycle time.

The commissioning software cannot be exited while a movement is run-
ning.

All operating modes are described in detail in the product 
manuals. Therefore, this manual does not describe the 
details of the operating modes.

Profile position In Profile Position operating mode, a movement with an adjustable mo-
tion profile is performed from a start position to a target position. The 
value of the target position can be specified as either a relative or an ab-
solute position.

You can set a motion profile with values for acceleration ramp, deceler-
ation ramp and target speed.

Figure 5.8 Operating mode Profile Position

Profile Velocity In the operating mode Profile Velocity, the drive accelerates to an adjust-
able target speed of rotation. You can set a motion profile with values for 
acceleration and deceleration ramps. 

Figure 5.9 Operating mode Profile velocity
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Homing The operating mode Homing establishes an absolute position reference 
between the motor position and a defined axis position. Homing can be 
carried out by a means of a reference movement or by position setting.

Figure 5.10 Operating mode Homing

Jog The motor is moved at slow or fast jog speed with the buttons. The motor 
moves as long as the button is held down. When you release the button, 
the motor is decelerated to a standstill.

Figure 5.11 Operating mode Jog

Electronic gear In the operating mode Electronic Gear, reference signals are supplied in 
the form of A/B signals or pulse/direction signals. A new position refer-
ence value is calculated on the basis of these signals plus an adjustable 
gear ratio.

Figure 5.12 Operating mode Electronic Gear
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Oscillator

In the Oscillator operating mode, the motor is moved corresponding to a 
voltage-dependent reference speed. There are two options:

• Selection of speed of rotation directly in the window by entering the 
value or using the slider.

• Supply of the value via the analog input ANA1. The voltage value 
can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" 
buttons.

Figure 5.13 Operating mode Oscillator

@ WARNING
UNEXPECTED MOVEMENT

In this operating mode, an unknown voltage value at the analog input 
may cause an unexpectedly high speed of rotation of the motor.

• Observe the voltage value at the analog input when starting the 
operating mode .

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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Speed control

In the Speed Control operating mode, the motor is moved corresponding 
to a voltage-dependent reference speed. There are two options:

• Selection of the value directly in the window by entering the value or 
using the slider

• Supply of the value via the analog input ANA1. The voltage value 
can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" 
buttons.

Figure 5.14 Operating mode Speed Control

@ WARNING
UNEXPECTED MOVEMENT

In this operating mode, an unknown voltage value at the analog input 
may cause an unexpectedly high speed of rotation of the motor.

• Observe the voltage value at the analog input when starting the 
operating mode .

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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Current control

In the Current Control operating mode, the motor is moved correspond-
ing to a voltage-dependent reference current. There are two options:

• Selection of current directly in the window by entering the value or 
using the slider

• Supply of the value via the analog input ANA1. The voltage value 
can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" 
buttons.

Figure 5.15 Operating mode Current Control

@ WARNING
UNEXPECTED MOVEMENT

In this operating mode, an unknown voltage value at the analog input 
may cause an unexpectedly high speed of rotation of the motor.

• Observe the voltage value at the analog input when starting the 
operating mode .

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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Autotuning

Autotuning determines the friction torque, a constantly effective load 
torque, and considers this in the calculation of the mass moment of in-
ertia of the entire system.

Figure 5.16 Autotuning

@ WARNING
UNEXPECTED MOVEMENT

Autotuning moves the motor in order to tune the controller. Incorrect 
parameters may cause unexpected movements or the loss of moni-
toring functions.

• Check the parameters AT_dir and AT_dis. The distance 
required for the deceleration ramp must also be taken into 
account.

• Verify that the parameter LIM_I_maxQSTP for QuickStop is cor-
rectly set.

• If possible, use the limit switches LIMN and LIMP.

• Verify that a functioning button for EMERGENCY STOP is within 
reach.

• Make sure that the system is free and ready for the motion before 
starting the function.

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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5.5.3 Recording and optimizing

Introduction The commissioning software provides the "Recording/Tuning" function 
for visualizing internal device data during movements. The connected 
device stores the movement data to an internal memory for a defined re-
cording period and then sends it to the PC. The PC processes the data 
and displays them in the form of charts or tables.

Recorded data can be saved on the PC, see chapter 5.3.1 "Saving a 
file", and can be archived or printed for documentation purposes.

Use the menu item "⇒ Functions ⇒ Record/Tuning..." to start the 
"Record" function.

Figure 5.17 Recording

Elements of the recording window:

(1) Buttons
(2) Chart with the recorded data
(3) Tabs for recording, trigger and tuning

Chart A chart is only shown if at least one parameter was selected.

Each of the selected parameters is shown in a distinct color.
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Buttons

Figure 5.18 Buttons

(1) Starting recording
(2) Stop recording
(3) Manual zoom, infinitely variable zoom of x axis and y axis
(4) Zoom Box
(5) Zoom in, y axis
(6) Zoom out, y axis
(7) 1nd display of values for a specific time
(8) Reset zoom, auto zoom
(9) Invert y axis
(10) Display table of recorded values
(11) Enter comment
(12) Print recording
(13) Save recording
(14) Open recording

Tab "Record" The "Record" tab allows youu to configure the recording function.

Figure 5.19 Tab Recording

The "Parameters" dropdown lists allow you to select the desired param-
eters. 

The "Timebase" dropdown list is used to set the time resolution. The 
smaller the "Timebase", the shorter the maximum recording time.

The desired number of measurement points is entered in the "Measure-
ments" field. A maximum of 100 measurements can be taken during one 
recording run.
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Tab "Trigger" The desired triggering for the recording is configured on the "Trigger" 
tab. Recording starts once the specified condition has been met.

Figure 5.20 Tab Trigger

The parameter to be monitored is selected from the "Trigger" dropdown 
list.

The condition the selected parameter must meet for the recording to be 
started is selected from the "Condition" dropdown list.

Enter a decimal value in the "Value" field; this is the comparison value for 
the condition the parameter must meet for recording to start.

The "use mask" checkbox allows you to indicate whether the value that 
is read out is masked before it is compared to the value specified for the 
condition.

The Mask function allows you to 'hide' individual bits of an actual value 
before it is compared to the comparison "Value". The mask is entered in 
hexadecimal notation. Each digit of the hex value describes 4 bits so that 
the 8 hex values represent all of 32 possible bits of a value. The actual 
value of the monitored parameter is added to the mask (binary addition). 
If the result matches the specified comparison value, recording is 
started.

For example, if the value 0x00000005 is set, this means that only bit 0 
and bit 3 are used for comparison to the comparison "Value".

The delay for starting recording after the condition has been satisfied is 
defined in the "Delay" field.
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Tab "Tuning" Movements, for example a positive step, can be triggered on the "Tun-
ing" tab. They can be evaluated for graphic optimization.

Tuning can only be started if the "Enable" switch is set to "On".

Figure 5.21 Tab Tuning

The "Amplitude" field is used to set the maximum amplitude of the ref-
erence value.

The duration of a period is set in the "Period" field.

The signal type for the reference value is set in the "Signal type" drop-
down list.

The controller to be used is set in the "Type" dropdown list.

The number of periods is specified in the "Count" field.

Starting recording Use the "Start recording" button to start recording.

The recorded data is sent to the PC. The data is then visualized.
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5.5.4 Inputs and outputs

The screenshots below may be different or unavailable in 
your system due to different functionalities of the devices.

The function "Inputs+Outputs" is used to monitor and display the analog 
and digital inputs as well as the digital outputs.

Use the menu item "⇒ Functions ⇒ Inputs+Outputs..." to start the func-
tion "Inputs+Outputs".

Figure 5.22 Inputs and outputs

Forcing The “Forcing” function offers the option of setting specific digital inputs, 
specific digital outputs and the voltage at the analog inputs directly. The 
currently available signal is disabled during this process. For example, 
this option can be used to apply the specified voltage via the analog in-
put in "Oscillator" mode.

@ WARNING
UNEXPECTED MOVEMENT

Changing the settings may cause unexpected motor movements.

• Only changes settings if operation of the motor cannot result in 
hazards.

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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5.6 Diagnostics

The software provides a range of diagnostics and information functions 
for error detection and troubleshooting in various windows.

5.6.1 Device information

Use the menu item "⇒ Diagnostics ⇒ Device infos..." to display infor-
mation on the device.

Figure 5.23 Device info

The device information window provides important information such as 
device type or serial number for diagnostics and service purposes.
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5.6.2 Error memory

Use the menu item "⇒ Diagnostics ⇒ Error memory..." to display the er-
ror memory.

Figure 5.24 Output of error memory

The "Delete memory" button clears the error memory and the list of er-
rors displayed.

The "Read out again" button updates the error list.

The "Close" button closes the "Error memory" window.

Current error The current error, e.g. limit switch (LIMP/LIMN/REF), is output in the left 
section.

Last error The current value of the operating hours meter and the error messages 
are displayed in the right part of the window.

The "Fault history" table shows the error messages in chronological or-
der. The "Device status" column consists of:
(error time)-(detailed error number)-(error class)

The "Additional information" table provides additional information on the 
error for every error message.

Erase error memory Use the menu item "⇒ Diagnostics ⇒ Delete error memory..." and the 
button "Delete error memory" to delete the "error history" list.
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5.6.3 Monitoring parameters

Use the menu item "⇒ Diagnostics ⇒ Object monitoring..." to monitor 
selected parameters of the device.

Figure 5.25 Monitoring parameters

The parameter to be monitored is selected from the list. Click the "Mon-
itor" button to display the parameter data in the table. You can add sev-
eral parameters to the table for monitoring.

A value can be written directly to a parameter with the "Write" button.
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6 Lexium CT M2

Depending on the product, the "Lexium CT ProductExplorer" starts the 
"Lexium CT M2" software.

6.1 The user interface

The following screenshot shows the user interface of the commissioning 
software.

Figure 6.1 User interface Lexium CT M2

(1) Menu bar
(2) Toolbar
(3) Control bar and status bar

The functions of the commissioning software can be accessed via the 
menu bar, the toolbar, the control bar and the status bar.
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6.1.1 The menu bar

The menu bar adapts to the task at hand. It only contains the functions 
required for and possible in the current situation.

For example, if there is no connection to the device, the function "⇒ 
Connection ⇒ Disconnect" is not available.

6.1.2 The toolbar

The toolbar provides fast, single-click access to frequently used func-
tions.

The buttons let you execute the following functions:

Figure 6.2 Toolbar

(1) ⇒ File ⇒ Open...
(2) ⇒ File ⇒ Save
(3) ⇒ Connection ⇒ RS485 connection...
(4) ⇒ Connection ⇒ CAN connection...
(5) ⇒ Connection ⇒ Disconnect
(6) ⇒ Parameter ⇒ Open parameter window...
(7) ⇒ Functions ⇒ Operating modes...
(8) ⇒ Functions ⇒ Recoding/Tuning...
(9) ⇒ Functions ⇒ Inputs+Outputs...
(10) ⇒ Diagnostics ⇒ Device info...
(11) ⇒ Diagnostics ⇒ Error memory...
(12) ⇒ Diagnostics ⇒ Object monitoring...

If you move the mouse pointer over a button, the software 
displays a "Tooltip"; in addition, a short description of the 
function may be shown in the "status bar".
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6.1.3 Control bar and status bar

The control bar and the status bar allow you to access the device. The 
control bar and the status bar can be used to enable the power stage 
and display various status information.

Figure 6.3 Control bar and status bar

(1) Access control
(2) Operating state
(3) Enable
(4) Stop
(5) Reset
(6) Current error
(7) Communication error
(8) Status information

Access control The commissioning software receives access control via the "Access" 
button. For more information on access control, see the product manual 
of the device.

Operating state The commissioning software shows the current operating state of the 
connected device. For more information on the operating state see the 
product manual of the device.

Enable The switch "Enable" allows you to enable and disable the power stage of 
the device. For more information on enabling or disabling the power 
stage see the product manual of the device.

Stop The "Stop" button allows you to stop the motor with a "Quick Stop". For 
more information on "Quick Stop" see the product manual of the device.

Reset The "Reset" button is used to acknowledge an error message. For more 
information on acknowledging error messages see the product manual 
of the device.

Current error The field shows the currently active asynchronous error.

Communication error The field shows the communication errors (synchronous errors) in 
chronological order.

Status information This information consists of:

• Line 1 shows whether the function "Halt" is active

• Line 2 displays the current motor position

• Line 3 shows the status of the access control

• Line 4 shows the control mode
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6.2 First steps

6.2.1 Important terms

Device data The term device data refers to all parameter values of a device. They are 
saved to the EEPROM of the device to avoid loss in case of a power out-
age.

Transferring device data Device data can be transferred between the device and the PC only if 
there is a connection. It is possible to transfer all parameters or groups 
of parameters.

NOTE: In a first step, the commissioning software transfers modified pa-
rameters to the RAM memory of the device. They remain there until the 
controller supply voltage is switched off . Note that the device data must 
be saved separately to the EEPROM memory so they are permanently 
available to the product.

Parameter file The device data can be saved to the PC and loaded.

On the PC, all device data is saved in one file, the parameter file. The 
commissioning software saves the complete parameter set in the file.

The PC and the device do not have to be connected if you want to edit 
the parameter file.
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6.2.2 The first connection

The device must be connected to the PC via the data interface.

Use the menu item "⇒ Connection ⇒ RS485 connection...." to connect 
to the device. This opens the "Connection" dialog box.

The screenshot below shows an example.

Figure 6.4 Selection of the connection data with RS485

Settings The "Modbus Point-to-Point" protocol must be used when the device is 
directly connected to the PC.

The "Modbus Multidrop" protocol must be used if the device is in a net-
work in which multiple devices are connected together. The correspond-
ing Modbus address must be set.

The setting of the Modbus address and the rate of transmission are de-
scribed in the product manual of the device.

In devices with DeviceNet support CAN may be selected for the connec-
tion instead of RS485. If the connection over CAN is selected, the fol-
lowing window opens:

Figure 6.5 Selection of the connection data with CAN

If you check the "don't show again" checkbox, this dialog box is not dis-
played the next time the CAN connection is selected. In such a case, the 
connection is immediately established with the specified settings.
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Connection The device data is transferred to the PC when a connection is estab-
lished. After transfer the commissioning software is connected to the de-
vice in online mode.

Start-up message The commissioning software shows a start-up message depending on 
the device. For example, in the case of new devices or device that must 
be reset to the factory setting the commissioning software shows the fol-
lowing information.

Figure 6.6 Start-up message
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6.3 Parameter file

Parameter files have the extension ".ifx". Even if there is no connection 
to the device, you can open and edit any device file on the PC. In addition 
to the parameter values, the file contains the contents of the error mem-
ory, all actual values and recorded data.

6.3.1 Saving a file

On the PC, device data on the PC can be saved to a parameter file, for 
example, to archive it for maintenance and service purposes. This also 
allows you to quickly commission additional devices of the same device 
version.

To save a parameter file on the PC, use the menu items"⇒ File ⇒ 
Save..." or "⇒ File ⇒ Save as...."

It is recommended to save all device data in the form of a 
parameter file after you have commissioned a device. This 
way the device can be put back into operation immediately 
after a repair.

6.3.2 Opening a file

Use the menu item "⇒ File ⇒ Open..." to open a parameter file on the 
PC.

If there is a connection to the device, the commissioning software 
checks whether the parameter file is compatible with the device.

If the parameter file is compatible with the device, the stored parameter 
values of the parameter file are compared to the parameter values of the 
device. Differences are highlighted by a colored background.

If the parameter file is not compatible with the device, the loading proc-
ess is canceled and an error message is displayed.
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6.3.3 Exporting parameters

All device parameters that can be written can be saved as a .csv file for 
further processing. This function can be accessed via the menu item "⇒ 
File ⇒ Export parameters...".

The file is saved with the extension ".csv". You can open and edit this file 
Microsoft Excel.

6.3.4 Printing parameters

The menu item "⇒ File ⇒ Print parameters..." allows you to print the de-
vice data. The printed data is arranged in groups:

• Simply Start

• Configuration

• Settings

• Motion

• Communication

• Data sheet

In addition, the device type, serial number and information on the soft-
ware are printed.
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6.4 Parameterization

The data of a device can be edited in the "Parameter" window. A con-
nection to the device is not required. The parameter values of a file can 
be modified in off-line mode and transferred to the device at a later point 
in time.

6.4.1 Opening the parameter window

Use the menu item "⇒ Parameter ⇒ Open parameter window..." to open 
the Parameter window.

Figure 6.7 Parameter window

The screenshot shows the parameter window. The contents of this win-
dow depends on the device version. However, the general structure is al-
ways the same. The left pane shows items, the associated parameters 
are displayed in the right pane.

Parameters of a group The parameter window shows the parameters associated with the se-
lected item. The list shows the names, values, unit, a description, the 
range and the Modbus address.

Changing parameter values The value of a parameter is changed in the "Value" column. Values with 
a gray background are read-only and cannot be modified.

Modified values that have not been transferred to the device are high-
lighted by a colored background. At the same time the parameter group 
to which the parameter belongs is highlighted by a red exclamation 
mark. As soon as the values have been transmitted to the device, the ex-
clamation mark is cleared.

To change a parameter value, you can enter the new value directly or 
choose it from a list.

Checking the value range The commissioning software checks whether the parameter values en-
tered are in the permissible value range. If the value entered is not in the 
valid range, the value is not accepted.
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6.4.2 Transferring parameter values

When the controller supply voltage to the device is switched on, the de-
vice data is automatically copied from the EEPROM to the RAM. The de-
vices only operate with the data contained in the RAM.

The data exchange between the device and the PC is controlled by the 
following menu items and buttons.

Menu items The menu items "⇒ Parameter ⇒ Send parameter group to drive" and 
"⇒ Parameter ⇒ Send all parameters to drive" allow you to transmit pa-
rameter values from the PC to the device.

The menu items "⇒ Parameter ⇒ Load parameter group from drive" and 
"⇒ Parameter ⇒ Load all parameters from drive" are used to transmit 
parameter values from the device to the PC.

Buttons The buttons let you execute the following functions:

Figure 6.8 Buttons for data transmission

(1) ⇒ Parameter ⇒ Send parameter group to drive
(2) ⇒ Parameter ⇒ Load parameter group from drive
(3) ⇒ Parameter ⇒ Send all parameters to drive
(4) ⇒ Parameter ⇒ Load all parameters from drive
(5) ⇒ Parameter ⇒ Save device parameters in EEPROM

Not all parameters can be transferred in operating state 
"Operation Enable". Parameter values that cannot be 
transferred are highlighted by a colored background.
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6.4.3 Restoring the factory settings

Use the menu item "⇒ Parameter ⇒ Reset to factory settings" to restore 
the factory settings of all parameters.

Figure 6.9 Restoring the factory settings

After confirmation with "OK" all device parameters are reset to the fac-
tory setting.

6.4.4 Resetting user parameters

All user parameters can be reset to the factory setting with the menu 
item "⇒ Parameter ⇒ Reset user parameters". The user parameters in-
clude all parameters except for (if present):

• Communication parameter

• Definition of the direction of rotation

• Signal selection at position interface

• device controller

• Logic type

• Start-up operating mode for "Local Control Mode"

• ESIM settings

• Motor type

• Processing the motor encoder position

• IO function

Figure 6.10 Reset user parameters

After validation with "OK" all user parameters are reset. The user pa-
rameters are not backed up to the EEPROM!
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6.4.5 Calculating control loop parameters

Use the menu item "⇒ Parameter ⇒ Calculate controller parameter" to 
reset the control loop parameters to the factory settings.

Figure 6.11 Resetting the control loop parameters

When you confirm with "OK", control loop parameters for the speed con-
troller and the position controller are reset.
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6.5  Functions

The "Functions" menu let you access the following functions:

• Operating modes

• Recording and tuning

• Inputs and outputs

The screenshots below may be different or unavailable in 
your system due to different functionalities of the devices.

6.5.1 Changing the operating state

An exclusive access is required for controlling the device with the com-
missioning software. Use the "Access" switch on the control and status 
bar to access the device. When the device is accessed, the software dis-
plays a safety instruction which must be confirmed with a key combina-
tion. For more information on access control, see the product manual of 
the device.

The device can now be set to operating state 6 "Operation Enable" with 
the commissioning software. In this operating state the power stage of 
the device is enabled. To do so, click the "Enable" switch. For more in-
formation on enabling or disabling the power stage see the product man-
ual of the device.

The device must be in operating state 6 "Operation Enable" for the func-
tions of the commissioning software to be executed.

@ WARNING
UNEXPECTED MOVEMENT

When the drive is operated for the first time, there is a risk of unex-
pected movements caused by possible wiring errors or unsuitable pa-
rameters.

• Perform the first test run without coupled loads.

• Verify that a functioning button for EMERGENCY STOP is within 
reach.

• Anticipate movements in the incorrect direction or oscillation of 
the drive.

• Only start the system if there are no persons or obstructions in 
the hazardous area.

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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6.5.2 Operating modes

Use the menu item "⇒ Functions ⇒ Operating modes..." to start the 
"Operating modes" function.

The various operating modes can be selected from the tabs in the Op-
erating Modes window.

The window is subdivided into two sections:

• Tab for the selected operating mode and for setting specific param-
eters (top section)

• Display of some status information (bottom section)

The user can switch between the tabs in the Operating Modes window 
without interfering with a currently active operating mode.

Device monitoring During movements, the connection to the device is cyclically monitored. 
If the connection between the PC and device is lost, the motor stops 
within the cycle time.

The commissioning software cannot be exited while a movement is run-
ning.

All operating modes are described in detail in the product 
manuals. Therefore, this manual does not describe the 
details of the operating modes.

Profile position In Profile Position operating mode, a movement with an adjustable mo-
tion profile is performed from a start position to a target position. The 
value of the target position can be specified as either a relative or an ab-
solute position.

You can set a motion profile with values for acceleration ramp, deceler-
ation ramp and target speed.

Figure 6.12 Operating mode Profile Position
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Profile Velocity In the operating mode Profile Velocity, the drive accelerates to an adjust-
able target speed of rotation. You can set a motion profile with values for 
acceleration and deceleration ramps. 

Figure 6.13 Operating mode Profile velocity

Homing The operating mode Homing establishes an absolute position reference 
between the motor position and a defined axis position. Homing can be 
carried out by a means of a reference movement or by position setting.

Figure 6.14 Homing tab

Jog The motor is moved at slow or fast jog speed with the buttons. The motor 
moves as long as the button is held down. When you release the button, 
the motor is decelerated to a standstill.

Figure 6.15 Operating mode Jog
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Electronic gear In the operating mode Electronic Gear, reference signals are supplied in 
the form of A/B signals or pulse/direction signals. A new position refer-
ence value is calculated on the basis of these signals plus an adjustable 
gear ratio.

Figure 6.16 Operating mode Electronic Gear

Oscillator

In the Oscillator operating mode, the motor is moved corresponding to a 
voltage-dependent reference speed. There are two options:

• Selection of speed of rotation directly in the window by entering the 
value or using the slider.

• Supply of the value via the analog input ANA1. The voltage value 
can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" 
buttons.

Figure 6.17 Operating mode Oscillator

@ WARNING
UNEXPECTED MOVEMENT

In this operating mode, an unknown voltage value at the analog input 
may cause an unexpectedly high speed of rotation of the motor.

• Observe the voltage value at the analog input when starting the 
operating mode .

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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Speed control

In the Speed Control operating mode, the motor is moved corresponding 
to a voltage-dependent reference speed. There are two options:

• Selection of the value directly in the window by entering the value or 
using the slider

• Supply of the value via the analog input ANA1. The voltage value 
can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" 
buttons.

Figure 6.18 Operating mode Speed Control

@ WARNING
UNEXPECTED MOVEMENT

In this operating mode, an unknown voltage value at the analog input 
may cause an unexpectedly high speed of rotation of the motor.

• Observe the voltage value at the analog input when starting the 
operating mode .

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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Current control

In the Current Control operating mode, the motor is moved correspond-
ing to a voltage-dependent reference current. There are two options:

• Selection of current directly in the window by entering the value or 
using the slider

• Supply of the value via the analog input ANA1. The voltage value 
can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" 
buttons.

Figure 6.19 Operating mode Current Control

@ WARNING
UNEXPECTED MOVEMENT

In this operating mode, an unknown voltage value at the analog input 
may cause an unexpectedly high speed of rotation of the motor.

• Observe the voltage value at the analog input when starting the 
operating mode .

Failure to follow these instructions can result in death, serious 
injury or equipment damage.



01
98

44
11

13
73

6,
 V

2.
00

, 0
9.

20
08

Lexium CT 6 Lexium CT M2

Commissioning software 71

Autotuning

Autotuning determines the friction torque, a constantly effective load 
torque, and considers this in the calculation of the mass moment of in-
ertia of the entire system.

Figure 6.20 Autotuning

@ WARNING
UNEXPECTED MOVEMENT

Autotuning moves the motor in order to tune the controller. Incorrect 
parameters may cause unexpected movements or the loss of moni-
toring functions.

• Check the parameters AT_dir and AT_dis. The distance 
required for the deceleration ramp must also be taken into 
account.

• Verify that the parameter LIM_I_maxQSTP for QuickStop is cor-
rectly set.

• If possible, use the limit switches LIMN and LIMP.

• Verify that a functioning button for EMERGENCY STOP is within 
reach.

• Make sure that the system is free and ready for the motion before 
starting the function.

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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6.5.3 Recording and optimizing

Introduction The commissioning software provides the "Recording/Tuning" function 
for visualizing internal device data during movements. The connected 
device stores the movement data to an internal memory for a defined re-
cording period and then sends it to the PC. The PC processes the data 
and displays them in the form of charts or tables.

Recorded data can be saved on the PC, see chapter 6.3.1 "Saving a 
file", and can be archived or printed for documentation purposes.

Use the menu item "⇒ Functions ⇒ Record/Tuning..." to start the 
"Record" function.

Figure 6.21 Recording

Elements of the recording window:

(1) Buttons
(2) Chart with the recorded data
(3) Tabs for recording, trigger and tuning

Chart A chart is only shown if at least one parameter was selected.

Each of the selected parameters is shown in a distinct color.
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Buttons

Figure 6.22 Buttons

(1) Starting recording
(2) Stop recording
(3) Zoom in, y axis
(4) Zoom out, y axis
(5) Infinitely variable zoom, x axis and y axis
(6) Zoom selected rectangle
(7) 1nd display of values for a specific time
(8) Change displayed values for first display

(x and y value, x value, y value, period, peak/peak value)
(9) 2nd display of values for a specific time
(10) Change displayed values for second display

(x and y value, x value, y value, period, peak/peak value)
(11) Restore original display
(12) Invert y axis
(13) Display table of recorded values
(14) Enter description
(15) Show/hide configuration
(16) Print recording

"Recording" tab The desired recording is configured in the "Recording" tab.

Figure 6.23 Recording tab

The desired parameters are selected in the "Available parameters" input 
field. A maximum of 4 parameters can be selected. If a parameter is no 
longer required, it can be deselected by a double-click on the name of 
the parameter.

The desired recording increment is select in the "Time base" input field. 
The smaller the "Time base" the smaller the maximum recording time.
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"Trigger" tab The desired triggering for the recording is configured in the "Trigger" tab. 
The recording starts once the specified event has occurred.

Figure 6.24 Trigger tab

The parameters for monitoring are selected in the "Trigger" input field.

The event that the selected parameter must meet to start the recording 
is selected in the "Event" input field.

The decimal whose comparison value the parameter must meet to start 
the recording is selected in the "Comparison value" input field.

If "Binary AND" or "Binary OR" is selected as the event, the "Mask" input 
field is opened.

The Mask function offers the option of hiding individual bits of an actual 
value before it is compared with the "Comparison value". The mask is in-
put in the hexadecimal system. Every position of the hex value de-
scribes 4 bits that through the 8 hex values shows all of the maximum 32 
possible bits of a value. The actual value of the monitored parameter 
added to the mask in binary form. If the revenue matches the specified 
comparison value, the recording is deleted.

For example, if the value 00000005 is set, this means that only bit 0 and 
bit 3 are used for comparison with the "comparison value".

The delay with which the recording is to be started after the condition 
has been met is set in the "time" input field. If a value with a minus sign 
is input, the recording is started before the selected event occurs.
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Tab "Tuning" Movements, for example a positive step, can be triggered on the "Tun-
ing" tab. They can be evaluated for graphic optimization.

Tuning can only be started if the "Access" and "Enable" switches are set 
to "On".

Figure 6.25 Tab Tuning

The "Amplitude" field is used to set the maximum amplitude of the ref-
erence value.

The offset of the amplitude in positive or negative direction can be set in 
the "Offset" field.

The duration of a period is set in the "Period" field.

The signal type for the reference value is set in the "Signal type" drop-
down list.

The controller to be used is set in the "Type" dropdown list.

The number of periods is specified in the "Count" field.

The maximum number of revolutions that can be triggered by tuning can 
be set in the "Range" field. This value can, for example, help to avoid a 
movement to block.

The "auto-start" radio buttons allow you to link the execution of the tun-
ing movement and the start of recording. If the option is set to "Off", the 
software displays a Start button. The Start button lets you trigger the tun-
ing movement separately from starting the recording. Settings that you 
may have made on the "Trigger" tab are lost lost if you set "auto-start" to 
"On".

Starting recording Use the "Start recording" button to start recording.

The recorded data is sent to the PC. The data is then visualized.
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6.5.4 Inputs and outputs

The screenshots below may be different or unavailable in 
your system due to different functionalities of the devices.

The function "Inputs+Outputs" is used to monitor and display the analog 
and digital inputs as well as the digital outputs.

Use the menu item "⇒ Functions ⇒ Inputs+Outputs..." to start the func-
tion "Inputs+Outputs".

Figure 6.26 Inputs and outputs

Forcing The “Forcing” function offers the option of setting specific digital inputs, 
specific digital outputs and the voltage at the analog inputs directly. The 
currently available signal is disabled during this process. For example, 
this option can be used to apply the specified voltage via the analog in-
put in "Oscillator" mode.

@ WARNING
UNEXPECTED MOVEMENT

Changing the settings may cause unexpected motor movements.

• Only changes settings if operation of the motor cannot result in 
hazards.

Failure to follow these instructions can result in death, serious 
injury or equipment damage.
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6.6 Diagnostics

The software provides a range of diagnostics and information functions 
for error detection and troubleshooting in various windows.

6.6.1 Device information

Use the menu item "⇒ Diagnostics ⇒ Device infos..." to display infor-
mation on the device.

Figure 6.27 Device info

The device information window provides important information such as 
device type or serial number for diagnostics and service purposes.
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6.6.2 Error memory

Use the menu item "⇒ Diagnostics ⇒ Error memory..." to display the er-
ror memory.

Figure 6.28 Output of error memory

Current error The current error, e.g. limit switch (LIMP/LIMN/REF), is output in the left 
section.

Last error The current value of the operating hours meter and the error messages 
are displayed in the right part of the window.

The "Fault history" table shows the error messages in chronological or-
der. The "Device status" column consists of:
(error time)-(detailed error number)-(error class)

The "Additional information" table provides additional information on the 
error for every error message.

Erase error memory Use the menu item "⇒ Diagnostics ⇒ Delete error memory..." and the 
button "Delete error memory" to delete the "error history" list.
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6.6.3 Monitoring parameters

Use the menu item "⇒ Diagnostics ⇒ Object monitoring..." to monitor 
selected parameters of the device.

Figure 6.29 Monitoring parameters

The parameter to be monitored is selected from the list. Click the "Mon-
itor" button to display the parameter data in the table. You can add sev-
eral parameters to the table for monitoring.

A parameter can also be monitored if you enter the Modbus address. 
The current value is displayed directly in the Value field.
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7 Diagnostics and troubleshooting

7.1 Error indication

Overview The commissioning software provides a range of diagnostics and infor-
mation functions for error detection and troubleshooting in various win-
dows and panes.:

• Diagnostics functions for the device
⇒ Diagnostics ⇒ Device info (see 5.6.1 "Device information" and 
6.6.1 "Device information")

• Error information on the device
⇒ Diagnostics ⇒ Error memory (see 5.6.2 "Error memory" and 
6.6.2 "Error memory")

• Monitoring parameters
⇒ Diagnostics ⇒ Object monitoring (see 5.6.3 "Monitoring parame-
ters" and 6.6.3 "Monitoring parameters")

• Error information on the control bar which is permanently displayed 
in the active window.

Error indication The cause of an error is displayed:

• At the device by means of the device-specific equipment, e.g. LED 
or segment displays

• By the error response of the device

• In the commissioning software as an error message in the control 
bar and as the last error message in the error memory

Error information is displayed on the toolbar along with the specific 
error message; the gray field below that contains additional informa-
tion.

Resetting error messages The additional information can be deleted by a double-click, but remain 
available in the error history.

The error state can be reset with the "Reset" button after the cause of 
the error has been corrected.
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8 Glossary

8.1 Units and conversion tables

The value in the specified unit (left column) is calculated for the desired 
unit (top row) with the formula (in the field).

Example: conversion of 5 meters [m] to yards [yd]
5 m / 0.9144 = 5.468 yd

8.1.1 Length

8.1.2 Mass

8.1.3 Force

8.1.4 Power

in ft yd m cm mm

in - / 12 / 36 * 0.0254 * 2.54 * 25.4

ft * 12 - / 3 * 0.30479 * 30.479 * 304.79

yd * 36 * 3 - * 0.9144 * 91.44 * 914.4

m / 0.0254 / 0.30479 / 0.9144 - * 100 * 1000

cm / 2.54 / 30.479 / 91.44 / 100 - * 10

mm / 25.4 / 304.79 / 914.4 / 1000 / 10 -

lb oz slug kg g

lb - * 16 * 0.03108095 * 0.4535924 * 453.5924

oz / 16 - * 1.942559*10-3 * 0.02834952 * 28.34952

slug / 0.03108095 / 1.942559*10-3 - * 14.5939 * 14593.9

kg / 0.453592370 / 0.02834952 / 14.5939 - * 1000

g / 453.592370 / 28.34952 / 14593.9 / 1000 -

lb oz p dyne N

lb - * 16 * 453.55358 * 444822.2 * 4.448222

oz / 16 - * 28.349524 * 27801 * 0.27801

p / 453.55358 / 28.349524 - * 980.7 * 9.807*10-3

dyne / 444822.2 / 27801 / 980.7 - / 100*103

N / 4.448222 / 0.27801 / 9.807*10-3 * 100*103 -

HP W

HP - * 745.72218

W / 745.72218 -
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8.1.5 Rotation

8.1.6 Torque

8.1.7 Moment of inertia

8.1.8 Temperature

8.1.9 Conductor cross section

min-1 (RPM) rad/s deg./s

min-1 (RPM) - * π / 30 * 6

rad/s * 30 / π - * 57.295

deg./s / 6 / 57.295 -

lb·in lb·ft oz·in Nm kp·m kp·cm dyne·cm

lb·in - / 12 * 16 * 0.112985 * 0.011521 * 1.1521 * 1.129*106

lb·ft * 12 - * 192 * 1.355822 * 0.138255 * 13.8255 * 13.558*106

oz·in / 16 / 192 - * 7.0616*10-3 * 720.07*10-6 * 72.007*10-3 * 70615.5

Nm / 0.112985 / 1.355822 / 7.0616*10-3 - * 0.101972 * 10.1972 * 10*106

kp·m / 0.011521 / 0.138255 / 720.07*10-6 / 0.101972 - * 100 * 98.066*106

kp·cm / 1.1521 / 13.8255 / 72.007*10-3 / 10.1972 / 100 - * 0.9806*106

dyne·cm / 1.129*106 / 13.558*106 / 70615.5 / 10*106 / 98.066*106 / 0.9806*106 -

lb·in2 lb·ft2 kg·m2 kg·cm2 kp·cm·s2 oz·in2

lb·in2 - / 144 / 3417.16 / 0.341716 / 335.109 * 16

lb·ft2 * 144 - * 0.04214 * 421.4 * 0.429711 * 2304

kg·m2 * 3417.16 / 0.04214 - * 10*103 * 10.1972 * 54674

kg·cm2 * 0.341716 / 421.4 / 10*103 - / 980.665 * 5.46

kp·cm·s2 * 335.109 / 0.429711 / 10.1972 * 980.665 - * 5361.74

oz·in2 / 16 / 2304 / 54674 / 5.46 / 5361.74 -

°F °C K

°F - (°F - 32) * 5/9 (°F - 32) * 5/9 + 273.15

°C °C * 9/5 + 32 - °C + 273,15

K (K - 273.15) * 9/5 + 32 K - 273.15 -

AWG 1 2 3 4 5 6 7 8 9 10 11 12 13

mm2 42.4 33.6 26.7 21.2 16.8 13.3 10.5 8.4 6.6 5.3 4.2 3.3 2.6

AWG 14 15 16 17 18 19 20 21 22 23 24 25 26

mm2 2.1 1.7 1.3 1.0 0.82 0.65 0.52 0.41 0.33 0.26 0.20 0.16 0.13



01
98

44
11

13
73

6,
 V

2.
00

, 0
9.

20
08

Lexium CT 8 Glossary

Commissioning software 85

8.2 Terms and Abbreviations 

Asynchronous error Error which is detected and signaled by the internal monitoring unit of 
the controller.

Default value Factory setting.

DOM The Date of manufacturing on the nameplate of the device is shown in 
the format DD.MM.YY, 
e.g. 31.12.06 (December 31, 2006).

Direction of rotation Rotation of the motor shaft in a clockwise or counterclockwise direction 
of rotation. Clockwise rotation is when the motor shaft rotates clockwise 
as you look at the end of the protruding motor shaft.

Limit switch Switch that signals overtravel of the permissible range of travel.

Power stage The power stage controls the motor. The power stage generates cur-
rents for controlling the motor on the basis of the positioning signals from 
the controller.

Fatal error In the case of fatal error, the drive is not longer able to control the motor, 
so that an immediate switch-off of the drive is necessary.

Fault Operating state of the drive caused as a result of a discrepancy between 
a detected (computed, measured or signaled) value or condition and the 
specified or theoretically correct value or condition.

Fault reset A function used to restore the drive to an operational state after a de-
tected fault is cleared by removing the cause of the fault so that the fault 
is no longer active (transition from state "Fault" to state "Operation En-
able").

Error class Classification of errors into groups. The different error classes allow for 
specific responses to faults, e.g. by severity.

LED Light Emitting Diode

Node guarding Monitoring of the connection with the slave at an interface for cyclic data 
traffic.

Parameter Device data and values that can be set by the user.

RS485 Fieldbus interface as per EIA-485 which enables serial data transmis-
sion with multiple devices.

Synchronous error Error signaled by the controller if it is unable to execute a command re-
ceived from the master.

Warning If not used within the context of safety instructions, a warning alerts to a 
potential problem detected by a monitoring function. A warning is not a 
fault and does not cause a transition of the operating state. Warnings be-
long to error class 0.
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9 Index

Symbols
"Recording" tab 73
"Trigger" tab 74

A
Abbreviations 85
Access control 55
Accessories 15

B
Before you begin

Safety information 11
Buttons 35, 62

C
Changing the operating state 37, 65
Commissioning software 15
Communication error 55
Control bar and status bar 29, 55
Current error 29, 50, 55, 78

D
Data interface 22
Device data 29, 56
Device information 49, 77
Device monitoring 38, 66
Diagnostics 49, 77, 81

E
Electronic gear 39, 68
Enable 29, 55
Erase error memory 50, 78
Error indication 81
Error memory 50, 78
Establishing a connection 31, 57
Exporting parameters 33, 60

F
First steps 22, 29, 56
Forcing 48, 76
Functions 37, 65
Functions of the commissioning software 9

G
General features 9
Glossary 83

H
Hazard categories 12
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Homing 39, 67

I
Important terms 22, 29, 56
Inputs and outputs 48, 76
Installation procedure 15
Intended use 11
Introduction 9

J
Jog 39, 67

L
Last error 50, 78

M
Menu bar 20, 28, 54
Menu items 35, 62
Monitoring parameters 51, 79

O
Opening a file 32, 59
Opening the parameter window 34, 61
Operating modes 37, 66
Operating state 29, 55
Oscillator 40, 68

P
Parameter file 30, 32, 56, 59
Parameterization 34, 61
Printing parameters 33, 60
Profile position 38, 66
Profile Velocity 38, 67

Q
Qualification of personnel 11

R
Recording and optimizing 44, 72
Required accessories 15
Reset 29, 55
Resetting error messages 81
Resetting user parameters 63
Restoring the factory settings 36, 63

S
Saving a file 32, 59
Source

Commissioning software 15
Starting recording 47, 75
Start-up message 58
Status information 29, 55
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Stop 29, 55
Supported devices 9
System requirements 15

T
Tab "Record" 45
Tab "Trigger" 46, 47, 75
Terms 85
Toolbar 28, 54
Transferring parameter values 35, 62
Tree View 20
Troubleshooting 81

U
Units and conversion tables 83
User interface 19, 27, 53
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